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Overview and Installation 

Software Overview 

The labZY-PSD application application is compatible with nanoPSD pulse-shape 

discriminating spectrometer. The labZY-PSD application provides an interface to 

nanoPSD, with the ability to set device operating parameters and the pulse-shape 

discrimination criteria, verify correct device operation, and acquire spectral data. A 

pulse-shape signature spectrum and pulse-height spectra  can be acquired 

simultaneously. Once the spectra are acquired from the hardware, they can be 

displayed and analyzed using basic spectroscopy and pulse-shape discrimination tools. 

The spectra can be stored in files for subsequent viewing and analysis.  

NOTE: The nanoPSD is not a digitizer and the labZY-PSD is not a software to process 

digitized data stored in the computer. The nanoPSD is a real time spectrometer. 

Unique Features 

The labZY-PSD application has dedicated features allowing setup and control of the 

pulse-shape analysis and pulse-shape discrimination of the nanoPSD spectrometer. 

The nanoPSD records four spectra simultaneously. These spectra are displayed by 

labZY-PSD in four separate spectral windows. The first window (S0 ) always displays 

the Time-Invariant Pulse-shape Signature (TIPS) spectrum. The other 3 spectral 

windows (S1-S3) display pulse-height spectra. Using region of interest (ROI) from TIPS 

spectrum the pulse-shape discriminator can be set so that each pulse-height spectrum 

is acquired only for events corresponding to specific TIPS. Unique feature of nanoPSD 

and the labZY-PSD application is the ability to setup and perform simultaneous pule-

shape and pulse-height discrimination. 

labZY-PSD application has a dedicated features related to the pulse-shape analysis. 

One of these features is automatic reporting of the figure of merit (FOM) of the TIPS 

spectrum. The automatic FOM reporting uses two peaks which can be identified using 

ROIs. Once set the FOM reporting will be held in the computer memory and will be 

reloaded at subsequent execution of the labZY-PSD application.. 

The labZY-PSD application offers unique features that support the advanced 

functionality of the nanoPSD hardware including support of Spectrum Hard Size and 

Spectrum Soft Size. All spectra are recorded by the hardware at the finest channel 

resolution possible, or the largest number of channels per spectrum (4096 channels). 

The number of channels recorded by the hardware is called the Spectrum Hard Size.  

The hard size spectra are the only spectra that are transferred from the hardware to the 

labZY-PSD application. The software stores the transferred hard size spectra in its 
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memory and files. The labZY-PSD application allows hard size spectra to be displayed 

and exported into a files as a Spectrum Soft Size which has fewer channels than the 

Spectrum Hard Size. The transformation from hard size to soft size is distortion free and 

does not destroy the original hard size spectrum. The labZY-PSD application allows for 

instant exploration of different spectrum sizes with a single spectrum recording. This is a 

significant improvement in comparison to traditional spectrometers, which offer 

hardware spectrum size selection and require spectrum recordings for each size in 

order to determine the optimal spectrum size. Because the Spectrum Hard Size spectra 

are always stored in as labZY spectrum files, it is recommended that all spectra are first 

stored as labZY spectrum files and then exported into soft size files. The soft size 

spectra can be exported into text files which can be used for processing with other 

spectrum analyzing applications. 

The labZY-PSD application, in conjunction with nanoPSD hardware, reports the True 

Incoming Counting Rate (ICR), correcting for the pile-up losses in the fast and/or slow 

channels of the spectrometer. labZY’s approach has better ICR estimation than the 

traditional method of ICR reporting, which is based on the counting rate of the fast 

discriminator and is always subject to pile-up counting loses. 

The labZY-PSD application provides enhanced peak information by calculating not only 

the full width at half maximum (FWHM) of the peaks, but by also reporting the peak 

Resolution In Percentage. This feature is valuable for assessing the resolution of 

scintillation detectors which is normally reported as percentage. 

Installation 

Windows 10 
Windows 8 
Windows 7 
Windows Vista 
Windows XP 
 
The labZY-PSD application can be installed either from the supplied flash drive as part 

of the nanoPSD package or by downloading the installation file on www.labzy.com. To 

install the software from the flash drive, insert the flash drive into the computer's USB 

port. In the labZY-PSD directory find and  execute setup.exe. To install the software 

from www.labzy.com, first download install_labZY-PSD_VERSION.zip and unzip or 

open it. The setup files and the labZY-PSD application are digitally signed by LABZY, 

LLC. It is recommended that an old version of the software be uninstalled before 

installing the new version of the labZY-PSDsoftware.  To begin the installation execute 

the setup.exe file. Once the installation begins follow the instructions of the software 

installer as outlined below.  
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Step 1 

 

Figure 1.1. Welcome page of labZY-PSD Setup Wizard window. 

Press “Next.” 

Step 2 

 

Figure 1.2 Confirm Installation page of labZY-PSD Setup Wizard window. 

Press “Next.” 
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Step 3 

 

Figure 1.3. Wait for the installation to complete 

Step 4 

 

Figure 1.4. Installation Complete page of labZY-PSD Setup Wizard window. 

Press “Close.” 
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After the installation is complete, a shortcut to labZY-PSD application will be placed on 

the desktop.   

 

Figure 1.5. labZY-PSD application icon. 

A folder called labZY- PSD X.XX (X.XX is the version number) will be created in the 

start menu. This folder contains shortcuts to the labZY-PSD application  and the utility to 

Uninstall labZY-PSD  The labZY group is shown below. 

 

Figure 1.6. labZY group in Windows 7 and Windows XP. 

 

 

Figure 1.7. labZY group in Windows 10. 

 

To uninstall the labZY-PSD application, execute the Uninstall labZY-PSD shortcut. If 

you need to reinstall or upgrade the labZY-PSD application, you must first run the 

Uninstall labZY-PSD utility.  
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Executing labZY-PSD 

 

The labZY-PSD application application can be started by executing one of the shortcuts 

to it. The default layout of the application may differ slightly depending on the Windows 

version and the computer screen resolution. It is recommended that the screen 

resolution is greater than 1440 x 900 pixels. Depending on the Windows security 

settings, the following message (Figure 1.8) may appear  

 

 

 

Figure 1.8. User Account Control - Verified Publisher: LABZY, LLC  message. 

Press “Yes” to allow the execution of the software. 

The labZY-PSD application will open a window displaying the default layout of the 

application (Figure 1.9). 

The labZY-PSD application can be terminated by executing the Exit command of the 

File menu. Alternatively, the “X” button in the upper right corner may be used to 

terminate the application. When labZY-PSD terminates, its current visual state, 

calibration and FOM data are stored and will be restored at the next run. No other 

information is preserved upon exiting the application. 
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Figure 1.9. labZY-PSD default layout. 
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Basic Components  
 

Menu 

 

File 

 

Figure 2.1.1. File menu. 

The File menu can Open Spectrum files and Save Spectrum As… in a labZY-PSD file 

format with default extension .lps. Additionally, it can Export Spectra to other file formats 

such as CSV. The labZY-PSD file format (.lps) is described in Appendix A.  

When saving and exporting a spectrum, a prompt is displayed to enter a Spectrum Tag.  

 

 
 

Figure 2.1.2. Spectrum Tag. 

 

This tag can be a brief description of the spectrum or any other information that can be 

used as a future reference when the file is opened and/or processed. The tag limit is 80 

characters. The tag is always saved in labZY formatted files and CSV exported files. 

Using commas in the CSV file tag will cause the comma-separated text fields to be 

treated separately by software applications such as Microsoft Excel.  
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IMPORTANT: Prior to saving a spectrum seen in the spectrum buffer, spectrum 

acquisition must be stopped for at least 3 seconds. This is because the spectrum buffer 

represents an active hardware spectrum acquisition. 

Saving spectra using the labZY-PSD file format also saves all of the hardware settings, 

along with the volatile data at the time of saving. To save the hardware settings, it is 

important that the Buffer tab of the Spectrum Window is selected and the labZY-PSD 

application is connected to nanoPSD. The ROI and calibration data are also stored in 

the labZY-PSD spectrum files.  

The Open Spectrum command can only open spectra saved in a labZY-PSD file format 

with extension .lps. When a spectrum is openned, it is loaded into a separate memory 

displayed under the File tab of the Spectrum Window. When the file tab is selected, the 

title bar of the Spectrum Window displays the file path and file tag of the spectrum being 

viewed. 

Furthermore, when a spectrum is opened, the hardware settings are recalled and stored 

in a virtual hardware. It is possible to transfer the virtual hardware settings to the 

physical hardware using the Copy Registers → File to Buffer command of the Hardware 

menu, which will load the previously stored hardware configuration into the physical 

hardware. While the File tab is selected for a loaded spectrum, all hardware-related 

menu commands, the hardware-related windows and the toolbar buttons are disabled, 

as they are separate controls from the Buffer hardware controls. These separate 

controls relate only to a virtual hardware and not to the nanoPSD connected to the 

labZY-PSD application. 

The calibration and ROI data are also recalled when a spectrum is opened. These data 

are also stored separately in memory associated with the File tab of the Spectrum 

Window. The calibration and ROI data can be exchanged between File and Buffer data 

storages using the appropriate Copy Calibration and Copy ROI commands in the 

Spectrum menu. 

Additionally the spectrum loaded by the Open Spectrum command and displayed in the 

File tab can be further analyzed by marking ROIs and/or by using the functions 

available in the Calibration Window.  Spectrum information of the File tab is separate 

from the spectrum information of the Buffer tab. The loaded spectrum in the File tab 

along with any calibration and/or ROI changes can be saved or exported under a 

different name. 
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Figure 2.1.3. labZY-PSD sample spectra in default layout. 

The Export Spectrum To…. command has a selection of different file formats. The 

spectrum can be exported either as a Hard Size Spectrum or as a Spectrum with the 

currently selected Soft Size. Note that exported spectra not in .lps format may not be 

opened by the labZY-PSD application.  

 

Figure 2.1.4. File menu → Export Spectrum To…  →  CSV File options. 
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The Export Trace Viewer.. command is used to export the numerical data 

corresponding to the currently displayed waveforms by the Trace Viewer. The RAW 

Traces are the digital signal data as transferred from the hardware. The digital signal in 

the Normalized Traces has been amplitude-corrected for the digital shaper gain. It is 

recommended to export traces as Normalized Traces. The logic signals are exported as  

a sequence of ones and zeros. The trace data is in CSV or TXT file formats suitable to 

be opened by Microsoft Excel or other spreadsheet applications. 

 

Figure 2.1.5. File menu → Export Trace Viewer… options. 

 

Edit 

 

 

Figure 2.1.6. Edit menu → Copy Spectrum options. 

 

The Edit menu has commands that allow copying of the docking windows visual content 

to the clipboard. Note that the copied images are exact copies of the windows and their 

content as shown on the display. If other windows block the visual content of the 

windows being copied, the blocking overlay will be captured upon executing the copy 

commands. The Copy Spectrum command has two selectable options in a submenu. 

The Spectrum option will copy only the spectrum area of the Spectrum Window. The 
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Window option will capture the entire Spectrum Window including its border and 

caption, and can be executed using the keyboard shortcut Ctrl+C. 

 

 

a) 

 

b) 

Figure 2.1.7. Clipboard Images: a) Copy Spectrum → Spectrum;  

b) Copy Spectrum → Window (Ctrl+C). 

 

 

Figure 2.1.8. Edit menu → Copy Trace View options. 
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The Copy Trace View command will copy the visual content of the Trace Viewer to the 

clipboard. This command has two options. The Traces option will copy only the trace 

area of the Trace Viewer. The Viewer option will capture the entire Trace Viewer 

window including the window border and all Trace Viewer controls as displayed on the 

screen. It is recommended that the Trace Viewer window is undocked to avoid 

interference with other windows.   

               

 

         a)       b) 

Figure 2.1.9. Clipboard Images: a) Copy Trace View → Traces;  

b) Copy Trace View → Viewer. 

 

View 

 

Figure 2.1.10. View menu. 
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The View menu controls the appearance of the application. The Toolbars and Windows 

command offers a submenu to turn the Toolbars(Standard, Hardware Control, View 

Control) and the Docking Windows ON or OFF. A check mark next to a window or a 

toolbar indicates that the corresponding window or toolbar is turned ON.  By selecting 

the Status Bar command, the Status Bar can be turned ON or OFF. 

 

 

Figure 2.1.11. View menu  →  Toolbars and Windows options. 

The Application Look command has submenus with different application styles. Some 

Windows versions may not support or correctly display some of the styles. The default 

style is Black Style. 
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Figure 2.1.12. View menu  →  Application Look  →  More Styles. 

Restore Layout restores the size, position, and other view attributes from when the 

application was last opened. This command is useful if the docking windows become 

hidden or scrambled. Note that at exit, labZY-PSD stores the current appearance of the 

application, which is automatically reloaded at the next start. This reloaded appearance 

will be restored if the Restore Layout  command is executed. 

Default Layout restores the size, position, and other view attributes to the default state 

at the time of the labZY-PSD installation. 

 

Hardware 

 

Figure 2.1.13. Hardware menu. 

The Hardware menu has various controls related to the labZY hardware. The Port 

command allows the user to choose a computer communication port (COM port) to 

which the nanoPSD device is connected. This command may also be used to identify 



 

©2019 labZY  labZY-PSD  User Manual  Rev. 1a www.labzy.com     19 
 

the port to which a nanoPSD device is connected. The port identification can only be 

performed for USB ports. To identify the port, start the labZY-PSD application and 

disconnect the nanoPSD device of interest from the computer. Execute the Port 

command from the menu. A port dialog will open. 

 

Figure 2.1.14. Available ports (Hardware > Port). 

Take note of the drop-down list of available ports. Close the port selection. Connect the 

nanoPSD to an available USB port. Wait until the USB driver installs. Reopen the 

dropdown list of ports. The new USB port should appear in the drop-down list when 

compared with the port list before the hardware connection. If the port list does not 

change, then either the USB driver was not installed correctly or the hardware failed to 

connect to the USB port. If the port of the labZY device is identified, select the relevant 

port and close the dialog by pressing “OK.”  

Once the port has been identified and selected, the labZY-PSD application can 

establish connection to the hardware by executing the Connect command. The Connect 

command is disabled during an active connection. 

The AutoConnect command does not require port selection and will automatically 

search for nanoPSD devices and connect to them. It is strongly recommended that the 

AutoConnect command is used to connect automatically  to nanoPSD devices.  

  

Figure 2.1.15. labZY Port Finder window during a search. 
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If more than one device is found, the AutoConnect dialog will present a drop list to 

choose a port. The found devices in the drop list will be identified by their serial number 

and the port they are connected to. Select the port of the device of interest and press 

the “OK” button.  

If the AutoConnect fails to find a device, it may be executed a couple of more times. If 

no ports are found after few attempts, a hardware connection and/or driver installation 

troubleshooting must be performed. The Disconnect command will disconnect the 

labZY-PSD application from the hardware. The Disconnect command is disabled if no 

hardware is connected. 

The Copy Registers command is used to transfer hardware settings from spectrum 

Buffer to File and vice versa. It is strongly recommended that the users exercise 

extreme caution as the action caused by this command is not reversible. It is 

recommended to save the hardware settings before executing the Copy Registers 

command. To save the hardware settings, use Save Spectrum As… to store a Buffer 

spectrum of a connected labZY device. The spectrum can be blank. The labZY 

spectrum file record always includes the hardware settings.  

Every saved spectrum has hardware settings stored in it. These settings can be 

transferred to the hardware by executing the Copy Registers → File to Buffer command. 

To transfer settings to a labZY device, first establish a connection between the device 

and the labZY-PSD application. Next, open a file containing the hardware settings to be 

uploaded to the hardware.  Execute the Copy Registers → File to Buffer command 

accepting the displayed warning. This should complete the transfer. Note that only 

hardware-related settings can be transferred. For example, the Soft Size setting will not 

be transferred as it is a pure software feature.  

 

Figure 2.1.16. Hardware menu  →  Copy Registers options. 
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The Copy Registers → Buffer to File command can be used for a temporary storage of 

hardware settings while the labZY-PSD application is running. If needed, these 

temporarily stored settings can be restored to the hardware using the Copy Registers → 

File to Buffer command. Although it is possible to modify the hardware settings of saved 

spectra, such practice should be avoided as the original hardware settings saved with 

the corresponding spectrum will be permanently lost.  

When a labZY device is connected, the About Hardware command will be enabled. This 

command opens an information window displaying hardware specific information such 

as the serial number, the expected time constant of the input signals, the version of the 

FPGA design, and other hardware related details.  

 

Figure 2.1.17. About hardware. 

Spectrum 

 

Figure 2.1.18. Spectrum menu. 

 

The Spectrum menu controls various aspects associated with the acquired spectra or 

the spectra opened from files. The Soft Size command opens a submenu with choices 

of the spectrum soft size. A check mark next to a soft size indicates the current 

selection. The soft size is controlled independently for the Buffer and the File spectra. 
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Figure 2.1.19. Spectrum menu  →  Soft Size options. 

The Soft Size selection applies to the spectrum visible in the Spectrum Window. When 

switching between different soft sizes, the ROI and the calibration coefficients are also 

adjusted accordingly.  

The Color command invokes a dialog to adjust the colors used to display the spectrum 

and associated features. The color can be adjusted individually for each spectrum 

window S0 to S3 or common collor settings for all spectrum windows. Specific colors 

can be set by pressing the corresponding button in the Adjust Colors dialog. To set the 

default colors, press the Default button. The “OK” button will confirm the color selection. 

The “Cancel” button will disregard any color changes. Color settings are stored at the 

termination of the labZY-PSD application and will be automatically restored at the 

consecutive execution of the software.  

 

Figure 2.1.20. Adjust Colors Dialog. 
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The Captions command will open a dialog to enter spectral window captions. The 

Captions are stored upon exiting the labZY-MCA and will be automatically restored at 

next execution of the software. 

 

Figure 2.1.21. Widow Captions Dialog. 

 

 

The ROI Mode command determines how the ROI (Region of Interest) is marked. To 

understand how to mark an ROI, refer to Mouse and Keyboard Functions. There is no 

limit on the number of marked ROI besides the limit of available channels in the full 

spectrum. 

 

Figure 2.1.22. Spectrum menu  →  ROI Mode options. 
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The Mark Over mode is the default mode. While marking an ROI, any channel the 

cursor is moved over, will be marked as an ROI. All previous ROI that the cursor 

touches or passes over will be connected. Thus, in this mode an ROI will be marked 

between the extremes of the cursor movement plus any ROIs touched by the cursor at 

its extreme positions. 

The ROI mode From Cursor will mark the ROIs from the current cursor position either to 

the left-end cursor position or to the right-end cursor position. In this mode, only one 

previous ROI can be attached to the newly created ROI. 

 

Figure 2.1.23. Spectrum menu  →  Copy ROI options. 

 

The ROIs and the calibration settings can be copied between File and Buffer spectrum 

windows. For this purpose, the Copy ROI and Copy Calibration commands may be 

used. Note that these operations destroy the corresponding settings in the destination. 

Once executed, these operations are not reversible. It is important that the spectrum 

soft size setting is the same for the source and the destination. 

The Copy ROI → File to Buffer and Copy Calibration → File to Buffer commands can be 

used to recall the ROI and calibration data stored in spectrum files to the spectrum 

Buffer. 
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Figure 2.1.24. Spectrum menu  →  Copy Calibration options. 

 

Utility 

 

Figure 2.1.25. Utility menu. 

The Utility menu has only one command FPGA. The FPGA command is used to update 

the FPGA design of a connected labZY device. If no device is connected to the labZY-

PSD application the FPGA command will issue a warning message and no further 

action will be performed.  

If a device is connected to the labZY-PSD application the execution of the FPGA 

command will open a dialog (FPGA) that allows the upload of an FPGA design to the 

connected device. 
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Figure 2.1.26. The FPGA dialog. 

To upload an FPGA design, execute the following steps: 

1) Press the "Browse" button to display the “Open” dialog. Browse to the directory of 

the FPGA design file with the extension “.lbf”.  Select the file and open it by pressing 

the “Open” button. 

 

Figure 2.1.27. The Open dialog to select FPGA design file. 
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Figure 2.1.28. The FPGA dialog ready for uploading the design file. 

2) Press "Upload" and wait up to 2-3 minutes until the design programming file is 

uploaded. If the upload fails repeat this step. 

 

Figure 2.1.29. The Upload progress indicator. 

 

3) For the uploaded FPGA design to take effect either cycle the power of the labZY 

device or press the "Config FPGA" button. Cycling the power will save the current 
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settings of the FPGA. Config FPGA will reload the settings of the FPGA from the last 

power on. The FPGA dialog after execution of Config FPGA is shown below. 

 

 

Figure 2.1.30. The upload of the FPGA design and the configuration of the FPGA are complete. 

 

4) The currently stored FPGA design in the labZY device can be verified against an 

FPGA design file (.lbf) by executing the Verify command. 

 

 

Figure 2.1.31. FPGA design and verification. 
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Help 

 

 

Figure 2.1.32. About labZY-PSD. 

The Help menu provides version information about the labZY-PSD application. There is 

no provision for interactive help topics at the time of writing this document. 
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Docking Windows 

 

The display information and control functions of the labZY-PSD application are 

contained within docking windows. Docking windows are not permanently attached to 

the frame of the labZY-PSD application. Instead, they can be moved independently or in 

groups and positioned anywhere on the computer screen. The docking windows can be 

docked at the sides of the main frame of the labZY-PSD application. When undocked, 

like any window, these windows can be resized. To group docking windows into one 

tabbed window, drag them and align their title bars. To pull a tabbed window out 

of a tabbed group, grab the window tab and move it away from the group. To 

restore the last position of a window double click the title bar. 

Spectrum Windows 

There are four spectrum windows with designation S0, S1, S2, and S3. The spectra in 

the four spectrum windows are recorded simultaneously. The Spectrum Windows have 

two tabs. The first tab is the Buffer tab. When the Buffer tab is selected, the spectrum 

from connected hardware device is displayed in the window. Selecting a tab in one of 

the S0-3 windows causes selection of the same tab in all spectrum windows.The 

content of the Buffer window is automatically updated by the nanoPSD hardware when 

the Auto Update button of the Acquisition Window is checked. 

The File tab displays spectra loaded from files. When a spectrum is opened, the File tab 

is selected automatically. When the File tab is selected all hardware controls are 

disabled including the hardware related toolbar buttons. 

To control the spectrum display or to move the cursor, the Spectrum Window must be 

selected by clicking the mouse within the window. The mouse, the keyboard and the 

View Control device bar are used to adjust the appearance of the spectra in the 

selected spectrum window. 
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Figure 2.2.1. Sample display of the four Spectrum Windows.  

 

Spectrum Window S0 

The Spectrum Window S0 always records TIPS spectra. The TIPS spectra are 

signature spectra of the pulse shape associated with measured radiation. In a typical 

neutron-gamma pulse-shape analysis the gamma peaks have centroids that are 

position at lower channels than the centroids of the neutrons. TIPS spectrum is similar 

for alpha-betta pulse-shape analysis - betta peak centroid is on the left of the alpha 

peak centroid. 

 

Spectrum Window S1 to S3 

The Spectrum Windows S1 to S3 record pulse-height spectra. The spectra in these 

windows can be selectively recorded based on pulse-shape discrimination. S1 and S2 

can also use be recorded using pulse-height discrimination simultaneously with the 

pulse-shape discrimination. The discrimination criteria are established using TIPS ROIs 

and PHA ROIs which are set in the PSD Window. S1 is typically used to record the raw 

pulse-height spectrum and its TIPS ROIs are set to accept all pulse-shapes. It is 

possible in some cases to set S1 in pulse-shape discriminating mode. S2 and S3 are 

used to record the pulse-shape discriminated PHA spectra  with simultaneous pulse-

height and pulse-shape discrimination. 
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PSA Window 

 

Figure 2.2.2. PSA Window. 

The PSA Window contains various controls that are related to the Digital Pulse-Shape 

Analyzer (PSA). Using these controls, the appropriate registers of the nanoPSD can be 

modified. Upon connection of the nanoPSD  to labZY-PSD application, the fields of the 

controls are updated with the values from the device’s hardware. Changing the fields 

while the nanoPSD  is connected will also change the corresponding nanoPSD  

registers. 

The nanoPSD FPGA designs implement multiple digital shapers. Two of these shapers 

can be adjusted by the user using the labZY-PSD application. These shapers are 

designated as Slow and Fast. The Slow shaper synthesizes trapezoidal pulses while the 

Fast shaper synthesizes inverse sawtooth pulse. The Slow Shaper is the main 

spectroscopy shaper. The pulse-height of the Slow Shaper pulses is used to record  the 

pulse-height spectra. Note that the nanoPSD can be used as a general purpose 

spectrometer using scintillation detectors such as NaI(Tl), LaBr etc. 

Both Slow and Fast shapers are also used in the determination of TIPS.  It is importnat 

that both shapers are set correctly or optimal TIPS and pulse-height spectrum 

acquisition. There are two groups in the PSA Window that are used to set the shaper 

parameters. 

 The controls in the group SLOW SHAPER allows adjustment of the Rise Time and the 

Flat Top of the Slow Shaper. Rise Time of this shaper should be adjusted to optimize 



 

©2019 labZY  labZY-PSD  User Manual  Rev. 1a www.labzy.com     33 
 

the signal-to-noise ratio. For plastic and liquid scintillators the default value of the 

RiseTime is 25 (200ns). The Flat Top is adjustment affects the TIPS spectrum. For 

short Flat Tops the separation of the neutron-gamma (alpha-betta) peaks is reduced. A 

longer flat top may increase the TIPS peak separation but may lead to a higher 

sensitivity to PMT after pulses, undetected (below the threshold) pile-up and other after-

pulse effects. The suggested values of the Flat Top are 25(200ns) for fast counting, 

100(800ns) for counting-FOM balance, 225(1800ns) for low counting rate and higher 

FOM. 

RISE TIME FLAT TOP FALL TIME

Time
 

a) 

 

Time

FALL TIME = RISE TIME

 

b) 

Figure 2.2.3. a) SLOW SHAPER - Trapezoidal Pulse; FALL TIME = RISE TIME; 

b) FAST SHAPER - Inverse Sawtooth Pulse; FALL TIME = RISE TIME 

The fast shaper parameters are set by the controls in the group FAST SHAPER. The 

fast shaper is used to identify the presence of detector events and as normalization 

parameter for TIPS. The Rise Time of the fast shaper is in fact the fall time of the 

inverse sawtooth pulse. A Rise Time is typically set between 5 (40ns) and 20 (160ns). 
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For standard nanoPSD FPGA designs the flat top of the fast shaper is fixed to 1 (8ns). 

In such case any attempt to change the flat top will be rejected. 

 

Both slow and fast shapers are equipped with low level noise discriminators (LLD).  The 

noise discriminator produces an active logic signal when the shaped signal is above a 

noise threshold. The group THRESHOLD contains the controls to set the noise 

discriminator thresholds. The thresholds for the slow shaper noise discriminator (SLOW 

LLD) and the fast shaper noise discriminator (FAST LLD) can be set manually by the 

edit controls SLOW and FAST respectively.  Entering zero in these controls will set the 

noise thresholds in Automatic mode (AUTO). The AUTO mode is independently set for 

SLOW LLD and FAST LLD. It is recommended to use AUTO mode for both shapers. 

However, in some cases, a pickup of high frequency or fast rising signals may trigger 

the fast discriminator in AUTO mode causing increased dead time. In such a case, the 

threshold should be adjusted manually until the pick-up signals are rejected by the 

FAST LLD. The Auto Margin control allows the addition of extra noise immunity to 

automatically set thresholds. The Auto Margins are ignored when the thresholds are set 

manually. 

When the noise thresholds are in auto mode, the thresholds are set by the hardware 

internal noise estimation circuit. This circuit estimates the thresholds using a statistical 

technique based on Gaussian probability density function of the noise distribution. The 

threshold estimation is shown in the group EST. THRESH., which are read only 

controls. 

Primary Time Constant 
τL -> LONG TC

Secondary Time Constant 
τS -> SHORT TC

*
CONVOLUTION

=
Pulse signal with two real 

poles at -1/τL and -1/τS 

a)

b)

c)

 

Figure 2.2.4. A pulse signal is characterized by LONG TC and SHORT TC. 
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The PSA of nanoPSD is designed to accept exponential signals with two real poles 

characterized by a long time constant (LONG TC) and a short time constant (SHORT 

TC). The PSA pulse shapers have two functional stages. The first stage unfolds the 

input pulses by removing the two exponential responses corresponding to the two real 

poles of the signal. That is, the result of the unfolding function is an unit impulse.  The 

unit impulse is fed to the second stage which performs a synthesis of 

trapezoidal/triangular pulse shapes.  

 

LONG TC

UNFOLDING

SHORT TC

UNFOLDING

TRAPEZOIDAL

PULSE SHAPE

SYNTHESIS

UNFOLDING SYNTHESIS

 

Figure 2.2.5. Unfolding to synthesis. 

The expected optimal LONG TC of the nanoPSD  is between 500ns and 600ns.. The 

SHORT TC normally depends on the response of the amplifiers in the amplification 

chain including the rise time response of the nanoPSD preamplifier. The SHORT TC 

may also represent the decay time constant of scintillation detectors.  

The LONG TC and the SHORT TC should be adjusted to minimize the tailing and/or the 

undershoot of the digitally shaped pulses (both the slow and fast shapers). SHORT TC 

has more influence on the fast shaper, while the LONG TC will affect both shapers. 

Adjustments of the time constants is performed using the Trace Viewer. A slow shaper 

Rise Time of 1μs is recommended to adjust the LONG TC. SHORT TC, if available, 

should be adjusted observing the pulses from the fast shaper. 

The group UNFOLDING provides means for adjustment of the LONG TC and the 

SHORT TC. The nanoPSD devices are delivered with  LONG TC already adjusted to 

match the time constant of the internal preamplifier. The SHORT TC adjustment of 

nanoPSD  is normally disabled and any attempt for adjustment will be ignored. 

The trapezoidal pulse shape synthesis can be represented as a convolution of two 

rectangular impulse responses. The peak value of the trapezoidal pulse represents the 

area under the shorter of the two rectangular impulse responses. The rise time of the 

trapezoidal pulse is equal to the width of the shorter rectangular impulse response. 

Therefore, the synthesis introduces gain equal to the rise time of the trapezoidal pulse 

shape. In addition, the ADC resolution differs from the total number of channels in the 

spectrum. These conditions requires a normalization of the pulse-height of the digitally 

synthesized trapezoidal pulse shapes.  
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The group GAIN NORMALIZATION presents control for automatic and manual 

adjustment of the gain normalization FACTOR. Although this adjustment is available, it 

is strongly recommended to use the automatic normalization by checking the AUTO 

checkbox. The normalization FACTOR in auto mode is a linear function of the SLOW 

SHAPER rise time – [FACTOR]=2.5[SLOW SHAPER]. The FINE checkbox 

compensates for the difference of the LONG TC setting and the expected LONG TC as 

coded into the FPGA design. It is safe to have both AUTO and FINE checked at the 

same time. 

The ballistic deficit correction factor BDC is used to optimize the usage of the ADC 

range so that the signals are digitized by utilizing most of the ADC quantization levels. 

For plastic and liquid scintillators the BDC is between 1 and 1.375. Setting BDC to 1 is 

always a safe choice. However, for optimum utilization of the ADC range the BDC can 

be fine trimmed using the Trace Viewer. The adjustment procedure is described in 

Appendix B.  

TIPS GAIN control is used to digitally adjust the gain of the TIPS spectrum. The range is 

from 1 to 500. However, the gain may be automatically reduced and the setting ignored 

when the setting is incompatible with the nanoPSD shaper settings. Typical values for 

the TIPS GAIN are in the range 2 to 5.  
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Figure 2.2.6. Illustration of the effect of the SYMMETRY parameter. Top: SYMMETRY = 0, 

Bottom: SYMMETRY > 0. Red and blue lines illustrate the centroid of the TIPS peaks. 

Due to nonlinearities in detector response (scintillator + PMT) often the centroids of the 

TIPS peaks change position as function of the energy as illustrated in Figure 2.2.6, top 

image. To correct for this nonlinearity the SYMMETRY parameter can be used. The 

SYMMETRY parameter can take values from -10000 to +10000. However, typical 

values are between -1000 and +1000. Setting SYMMETRY to zero is the safe way to 

start using nanoPSD and labZY-PSD.  Symmetry should be set positive if the low 

energy peak centroids are shifted towards higher TIPS channels compared to the 

centroids at higher energies as shownin Figure 2.2.6. Typical values of SYMMETRYfor 

nanoPSD connected to a stilbene scintillator is 0 ±100.. 

The BLR RESPONSE group controls the BLR of the SLOW and FAST shapers. The 

response of the BLR is inversely proportional to the value set for SLOW or FAST. A 

smaller number means more aggressive BLR. For moderate counting rates the BLR 

response should be in the range of 200 to 400. For higher counting rates the range is 20 

to 200. The symmetric mode (SYM) of the BLR is recommended for the SLOW shaper. 

Depending on the counting rates and the undershoots of the detector signals the SYM 

mode will require a careful evaluation to determine whether or not to use it.  

The ACC mode of the BLR is a special mode when AC coupled detectors have non-

linear response and cause severe undershoot  when recovering from overload 

condition. This situation is rare and in most cases ACC will be left unchecked. When 

ACC is checked the BLR operates in fast recovery mode when overload caused by the 

detector signals is detected - the INHIBIT signal becomes active LOW. Fig. 2.2.7 

depicts traces of ADC signal with undershoot, and the recovery of the slow shaper with 

and without engagement of the ACC. Avoid to use ACC mode unless the overload of 

the detector causes degradation of the resolution or a severe shift of the base line. 

 

 
a)    b)    c)  
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Figure 2.2.7. a) Overloaded detector signal; Slow Shaper - b) without ACC, c) with ACC. 

The main function of the fast shaper, along with the FAST LLD, is pile-up rejection 

associated with the slow shaper. Note that the fast shaper pulses are also subject to 

pile-up. When such pile-up occurs, the FAST LLD pulses will be treated as a single 

event pulse and pile-up rejection will fail.  

To improve the pile-up capability of the fast discriminator, an independent pulse-shape 

analysis of the fast pulse shape is performed (Figure 2.2.8). The pile-up rejection 

capability of the nanoPSD can be improved by checking the  ENHANCED checkbox in 

the PILE-UP Rejector group. The enhanced pile-up rejection algorithm does not use 

timing information and is not sensitive to pulse-tailing.  In rare cases the ENHANCED 

pile-up rejection may be sensitive to high frequency pick-up signals. 

 

DISTORTED

PULSE 

SHAPE

FAST

SHAPER

FAST

DISCRIMINATOR

PILE-UP

REJECTOR REJECT

a) b)

NORMAL
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SHAPE

 

Figure 2.2.8. a) Pile-up free fast shaper/discriminator; b) fast shaper pile-up and pulse-shape 

distortion.   

Figure 2.2.9 shows normal pile-up rejection(a) and enhanced pile-up rejection (b) as 

seen by the Trace Viewer. The signal trace depicts the fast pulse shape. The Trace 

Viewer is triggered by the internal pile-up rejector signal which has an active low logic 

level. 
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   a)      b)  

Figure 2.2.9. a) Traditional pile-up rejection; b) enhanced pile-up rejection.   

 

 

 SIGNALS Window 

 

 

Figure 2.2.10. SIGNALS Window. 

The SIGNALS Window contain the controls of the analog signals,  analog signals 

related functions and configuration of the logic signals functions of the nanoPSD. 

The DIGITAL IO group contains controls for the digital Inputs and digital IO functionality. 
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Figure 2.2.11. DIGITAL Inputs and IO options. 

 

Signal (Input) D can accept analog signals only. The analog signals applied to this input 

are digitized by a slow ADC. Do not apply pulse signals or high frequency signals 

to Input D!  For best performance of the nanoPSD Input D should be left open.   

The digital signal R is an input/output signal. Input R can be used as a source for 

coincidence/anticoincidence.  The signal R can also be used as an output. The signal R 

output function is automatically disabled when signal R is enabled as an input. It is 

important that the R signal is not driven by an external signal when it is set as an output 

as this may cause a permanent damage to nanoPSD. 

The DIGITAL OUTPUTS group contains controls for the digital outputs of nanoPSD.  
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Figure 2.2.12. DIGITAL OUTPUTS configuration options. 

 

The OFFSET group relates to, and is of extreme importance for the operation of the 

ADC and PSA. Offsets are especially important for the proper operation of the ADC. 

The offset concept and associated requirements are completely different from the old 

understanding and requirements used in analog based pulse shapers and spectroscopy 

ADC. IMPORTANT! The "zero offset" of the recorded spectra is not affected by 

these offsets. These are signal processing related offsets only. An offset at the 

input of the ADC allows digitization of the negative portion of the noise. The analog 

offset at the input of the ADC is referred to as the AMPLIFIER OFFSET. The digital 

offset that is subtracted from the digitized signal is the ADC OFFSET. The AMPLIFIER 

OFFSET should be adjusted so that its digital equivalent is cancelled by the ADC 

OFFSET.  
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Figure 2.2.13. Offset cancellation. 

 

It is recommended that both the ADC DEFAULT and the AUTO options are used 

and the corresponding buttons are depressed. The labZY hardware incorporates 

automatic adjustment of the AMPLIFIER OFFSET so that it can be cancelled exactly by 

the ADC OFFSET.  

 

Figure 2.2.14. Offset group. 
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Some  measurements) may require manual adjustment of the AMPLIFIER OFFSET. To 

manually adjust the AMPLIFIER OFFSET, use the Trace Viewer window and the SAR 

button of the OFFSET group. Be sure to remove any radiation sources and to 

reduce the counting rate to as low as possible before making any adjustments. In 

the Trace Viewer window, set the Acquisition Mode to RND, the Horizontal setting to 20 

µs/div, the Vertical setting to 4k/div, and the Vertical Offset setting to zero (press the “0” 

button). Then select ADC in the Input section and press the RUN button of the Trace 

Viewer. 

In the OFFSET section of the SIGNALS Window, turn AUTO off and press the SAR 

button. The AUTO button will become inactive (grayed out). Observe the ADC trace in 

the Trace Viewer window. The ADC trace will shift upwards or downwards. The goal is 

to adjust the position of the ADC trace to the middle of the window. If the ADC trace is 

above the zero line (aligned with the Offset pointer), press the “--” button of the OFFSET 

section in the SIGNALS Window. If the ADC trace is below the zero line, press the “++” 

button. After pressing either button, wait at least five seconds until the ADC trace 

settles. Continue the sequence of pressing the “--” and “++” buttons according to the 

position of the ADC trace until the SAR button becomes active and the “--” and “++” 

buttons are greyed out. You may terminate this procedure by quickly pressing the 

AUTO button twice. You may need to adjust the Vertical Offset for more precise 

adjustments of the Amplifier OFFSET. The Amplifier OFFSET may be fine-tuned by 

modifying the offset value in the AMPLIFIER edit box. For more information about 

offset adjustments, please visit the support section of labzy.com.  

The GAIN group has controls to adjust the analog gain. The coarse gain COARSE of 

nanoPSD is fixed to ONE (1). The FINE control can be used to fine-tune the analog 

gain. The range of the fine gain is from 1 to 1.2 adjustable in 65536 steps. The preferred 

FINE GAIN is one (1) which minimizes the analog amplification noise. The read-only 

TOTAL field reports the total analog gain by multiplying the fine gain and the coarse 

gain.  

The STABILIZER group allows for setting and controlling  the gain stabilizer of the 

nanoPSD. The STABILIZER should only be used with spectra with distinctive peaks. 

For pulse-shape discrimination applications the STABILIZER should be 

DISABLED. The stabilizer adjusts the fine gain of the device. Therefore, in order to use 

the stabilizer the fin gain must be set at the middle of its scale - 1.10. The stabilizer offer 

maximum of 10% correction of the gain. Normally, the stabilizer is used with scintillation 

detectors which are sensitive to temperature variations. the stabilizer uses a reference 

peak from the acquired spectrum. For best results the centroid position of the peak must 

be greater than half of the spectrum scale. Pressing the SET button will open a dialog. 
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To automatically set the parameters of the stabilizer mark in S1 an ROI around the 

desired peak for stabilization and press the long button to generate recommended 

settings. You may also manually enter the peak parameters. To start the stabilization 

check the Enable box. It is important to let the stabilizer run for some time before 

starting an acquisition. The stabilizer is implemented in hardware and its operation is 

independent of the labZY-PSD application. 

 

        

Figure 2.2.15. Stabilizer controls. 

 

 

Figure 2.2.16. Stabilizer Setup Dialog. 
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PSD Window 

 

 

Figure 2.2.17. PSD Window. 

 

The PSD window has controls that are used to specify the spectrum acquisition in the 

Spectrum Windows S0 to S3. It is important to note that a single event from the detector 

can be recorded in one or more Spectrum Windows or the event may be ignored and 

not recorded in any of the Spectrum Windows. Therefore, it is very important to 

understand the spectrum acquisition as defined by the controls of the PSD Window. 

Fig. 2.2.18 shows the flowchart of the spectrum acquisition in S0 to S3. The only events 

being recorded are events that result in slow shaper amplitudes exceeding the Slow 

Thresh. and a fast shaper amplitude exceeding the Fast Thresh.. In other words for a 

detector event to be recorded both fast and slow low level discriminators (LLD) must be 

triggered. In addition events can be rejected if the Pile-Up rejector is enabled. 

If an event passes all of the criteria above the Pules Height of the slow shaper (PH) and 

the TIPS value are found and captured. Based on the settings in the PSD Window 

groups S0 to S3 are selectively incremented.  

There are four groups in the PSD Window. The first group "S1:ROI for TIPS" is used to 

control the data acquisition of the S0:TIPS spectrum window. In this group an ROI of the 

S1 spectrum window is entered. The purpose of this ROI is to specify a range of pulse-

heights (PH) of the slow shaper which is the main spectroscopy shaper. 
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Figure 2.2.18. Flowchart of the spectrum acquisition in S0 to S3. 

To enter the ROI select a region of interest in the S1 window. Place the cursor within 

the selected ROI and press the ROI button in the group to record the ROI in channels 

[chn]. If the spectrum in S1 window is calibrated and its calibration is enabled the ROI 

will also be displayed in calibration units, e.g. [keV].  If the nanoPSD is connected the 

ROI values will be stored in the hardware non-volatile memory and will be recalled 

every time the labZY-MCA software connects to the nanoPSD. The values of the ROI 

will be kept in the hardware even if the nanoPSD is turned off. Once the ROI is recorded 

in the "S1:ROI for TIPS"  the ROI in S1 can be deleted, modified or new multiple ROIs 

can be created for the purpose of calibration or analysis.  
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The range of "S1:ROI for TIPS"   ROI determines the slow shaper pulse-height (energy) 

range that will be used to increment the spectrum of S0:TIPS. Pulses with amplitudes 

outside this range will be ignored and will not contribute to the S0:TIPS spectrum. By 

selecting multiple  small regions of interest one can record a series of TIPS spectra to 

estimate the FOM as function of the energy. The all button will set an ROI that accepts 

al pulse-heights, effectively disabling the Pulse-Height discrimination for S0:TIPS. The 

MARCK BACK button allows marking back the ROI in S1 window. This is an useful 

feature when restarting the software or when the ROI has been deleted.  

The remaining 3 groups in the PSD accept ROIs in a similar fashion as the first group. 

The ROIs in these group are from the S0:TIPS spectrum window and are only displayed 

in channels [chn]. The group "TIPS:ROI for S1" determines the range TIPS values for 

S1 by entering an ROI marked in the TIPS spectrum or by pressing the ALL button. 

Normally the ALL is pressed which eliminates the pulse-shape discrimination for S1. 

This allow to record the full ,above the threshold pulse-height, (energy) spectrum in S1. 

.
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Figure 2.2.19. Relationship between PSD controls and the spectrum acquisition. 
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The groups "TIPS:ROI for S2" an "TIPS:ROI for S3"  are used to enter a pulse-shape 

discrimination range of TIPS by selecting appropriate ROIs in the S0:TIPS spectrum 

window. For example, if a neutron-gamma TIPS spectrum the gamma peak can be 

marked by an ROI and entered in the "TIPS:ROI for S2" while the marked neutron peak 

can be entered in "TIPS:ROI for S3". Fig 2.2.19 and Fig 2.2.20 illustrate the setting of 

S2 and S3 in simultaneous pulse-height and pulse-shape discrimination 
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Figure 2.2.20. Simultaneous pulse-height and pulse-shape discrimination. 

To set the ROIs in the PSD Window follow these steps assuming the signal processing 

has been set: 

 1. Connect the nanoPSD to the labZY-PSD application. 

 2. Press ALL in "TIPS:ROI for S1" resulting in ROI: from 0 to 4095. 

 3. Record a spectrum, S1 should display the full pulse-height spectrum 
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 4. Select an ROI in S1 for desired pulse-heights (energy) to be used for the 

 acquisition of the TIPS spectrum. 

 5. Erase spectrum and start new acquisition. TIPS spectrum should display a 

 pulse-shape signature spectrum as shown in Fig. 2.2.19 or Fig. 2.2.20. 

 6. Mark ROIs around the TIPS peaks to be used for pulse-shape discrimination. 

 7.  Place the cursor in each of these ROIs and press the ROI button of the 

 corresponding "TIPS:ROI for S2" and "TIPS:ROI for S3" groups. 

 8. Erase spectra and start a new spectrum acquisition. 

 

Acquisition Window 

The ACQUISITION Window contains the spectrum acquisition parameters and 

acquisition control settings. 

 

Figure 2.2.21. Acquisition Window. 

The AUTO UPDATE checkbox controls the data exchange between labZY-PSD 

application and the connected hardware. To continually update all data from the 

hardware, this checkbox must be selected. When the Trace Viewer is in acquisition 

state, this box is automatically unchecked to improve the update rate of the Trace 

Viewer. It is possible to recheck the box while the Trace Viewer is acquiring data; 

however, the update rate of the spectrum and the Trace Viewer will be reduced 

noticeably.  
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The preset time of the spectrum acquisition is set by the controls in the group  TIME. 

The preset time can be either LIVE TIME or REAL TIME. The preset time can be set in 

seconds.  The TIMERS group reports the elapsed real and live time. The dead time is 

also reported.  

The spectrum acquisition is controlled by the following buttons: START, STOP, RESET. 

START, STOP and RESET are also available as buttons of the HARDWARE 

CONTROL toolbar. 

The DATE/TIME button opens a dialog to select a time stamp for a given measurement. 

 

 

Figure 2.2.22. Time Stamp Dialog. 

The time stamp may use UTC, LOCAL or SYSTEM time. the UTC can be obtained from 

internet time server with accuracy of less than 50ms. The time stamp, stored in the 

hardware will be with an accuracy of 1s. If UTC is selected the labZY-PSD  software will 

automatically open the dialog seen in Figure 2.2.22 when selecting START or RESET if 

more than 300s have expired from the last internet time synchronization with an NTP 

time server.  It is possible to synchronize the computer local host clock with the 

obtained NTP time; this function, however requires that the labZY-PSD  is run as 

administrator. 

The Acquisition Window also displays the volatile data - nanoPSD internal temperature 

and the voltage at Input D as measured by the slow ADC. The volatile data changes 

constantly. When stored in files, the volatile data represent the volatile state at the time 

the file is being saved. 
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The COINCIDENCE group is used to set-up the coincidence/anticoincidence function of 

the nanoPSD. The coincidence function uses Input R (settings from the SIGNALS 

Window)  that drive an internal COINC_S signal. COINC_S can  be a direct coincidence 

source directly or indirectly by edge-triggering a coincidence window pulse. In either 

case the resulting signal (direct or indirect) is COINC_W . The 

coincidence/anticoincidence is between the internal STORE signal derived from the 

timing peak detector signal, and the COINC_W  signal. 

            

Figure 2.2.23. Coincidence Controls. 

The coincidence function is selected from the drop-down list. When the DISABLED is 

selected, the coincidence/anticoincidence circuit is disabled. 

When DIRECT is selected  the COINC_W  is  directly connected  to the  Input R logic 

signal and is in coincidence when high and in anticoincidence when low. By selecting 

the polarity (inverted or not) of Input R  the coincidence and anticoincidence functions 

can be reversed. 

When one of the WINDOW coincidence functions is selected a window logic signal is 

generated by the low-to-high transition of COINC_S. The width of the window logic 

pulse is set in the WinWidth control. In this case COINC_W is the window logic signal. 

The COINC_W signal can be delayed to align with the internal, peak-detector derived 

signal STORE. The delay is set by the D Delay control. The COINC_W can be selected 

to function as coincidence or anticoincidence signal. 

The internal STORE  signal can be delayed to accommodate coincidence or 

anticoincidence with external signals that may have long propagation delays or become 

active after the internal peak detection signal. The STORE signal delay is set by the 

Peak Delay control. Adjustments of the delays and the coincidence window width can 

be accomplished using the Trace Viewer. Double pressing the Input C trigger button will 

switch the Input C trace to COINC_S and the INHIBIT trace to COINC_W. 
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Figure 2.2.24. Timing diagrams of the built-in coincidence circuit: a) Input R (Coincidence HIGH) 

as DIRECT coincidence signal, active high or anti-coincidence signal, active low; b) Input R 

(Coincidence LOW) as DIRECT coincidence signal, active low or anti-coincidence signal, active 

high; c) positive edge and d) negative edge coincidence/anti-coincidence triggered signals. 
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The  SPECTRUM LOGGER allows repeated spectrum acquisition and storage. The 

logger is implemented in the labZY-PSD software and requires active connection with a 

nanoPSD device during the entire time of measurement and logging the spectra. 

The logger allows repeated storage of spectra acquired at identical settings for a preset 

number of RUNS. Each run of the logger represent a single spectrum acquisition for the 

preset LIVE or REAL time. At the end of the run the spectrum is stored, the spectrum 

memory is reset and a new spectrum acquisition is initiated. There is a gap between the 

runs. The minimum gap time is 1s or 2s when the REAL preset spectrum acquisition 

time is an odd number or even number of seconds respectively.  The gap may be longer 

depending on the speed of the computer to write the acquired spectra.  

The spectra are stored in files with file names that are combination of the FILE NAME 

(BASE) and the number of the run (starting with 1) saved in the file as shown below - 

five runs with base file name n-g_spectra: 

 

The storage folder is selected by pressing The FOLDER button. To start the logging the 

box  ENABLE is checked followed by a press of the START button. To stop the logging 

before the preset numbers of spectrum records are reached the ENABLE box must be 

unchecked. 

Each spectrum is time stamped. The time stamp of the first spectrum can be UTC 

synchronized or synchronized with the computer clock. a selection that can be made by 

pressing the TIME STAMP button before enabling the logger. The time stamps of all 

measurement following the first measurement are derived from the computer clock 

directly or  by applying the initial UTC offset if the UTC time stamp is used for the first 

measurement. The cock time drift can be estimated by finding the UTC offsets at the 

beginning and the end of the measurement. Consequently the time stamps of the 

individual measurement can be corrected using the clock uncertainty and drift 

measurements. 

The logging process will be terminated if the connection between the labZY-PSD and 

the nanoPSD fails due to power failure or communication errors or time out conditions. 
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Calibration Window 

The Calibration Window has the energy calibration settings. 

Each spectrum window (S0 to S3) has its own calibration 

settings independent from other windows. The window that a 

given Calibration applies to is indicated in the Calibration 

Window caption, e.g. Calibration S1 for S1 Spectrum 

Window. Buffer and File tabs also have their own sets of 

calibration data. 

labZY-PSD utilizes up to 10 points to calculate a second order 

calibration. To set the calibration coefficient, add up to 10 

channel-energy points. The entry of the CHANNEL data can 

be manual, ROI PEAK centroid or CURSOR position. To enter 

a PEAK centroid position or CURSOR position, place the 

cursor in the CHANNEL entry and press the left mouse button 

to place the cursor. For PEAK centroid position, select an 

ROI, place the spectrum cursor within the ROI, and press the 

PEAK button. To enter the CURSOR position, move the 

spectrum cursor to the desired channel and press the 

CURSOR button. The ENERGY values must be entered 

manually.  Press ADD POINT to transfer the 

CHANNEL/ENRGY values as a calibration point in the 

calibration points table. 

After all points are entered  the calibration coefficients can be 

calculated either using all points or a subset of calibration 

points selected by check marks. Calibration points can be 

removed or edited by first selecting the points (check mark) 

and then pressing the corresponding button. 

The calibration units are selected from the drop-down choice 

list. Check the Enable Calibration check box  to display the 

spectrum information in calibration units. 

The FOM SETTINGS group allows a selection of two peaks 

whose centroids and FWHM are used to calculate FOM. 

Select a ROI around desired peaks in the TIPS spectrum (S0). 

Place the cursor in the first peak and press PEAK 1. Place the 

cursor within the ROI of the second peak and press PEAK 2. 

The ROIs of the FOM settings can be marked back in the 

TIPS spectrum by pressing MARK 1 and/or MARK 2 buttons.  
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Spectrum Info Window 

 

The Spectrum Info Window displays read-only information 

about the spectra (S0 to S3) and acquisition related 

information. 

The CURSOR group displays the position of the spectrum 

cursor in channels or calibration units. The counts of the 

channel at the cursor position are also reported. 

The PEAK INFO group provides peak info when the 

spectrum cursor is within an ROI marking a spectral peak. 

The CENTROID, FWHM and FWTM are displayed either in 

channels or in calibration units.  

The FOM group displays the FOM of TIPS peaks as set in 

the Calibration window. PK1 and PK2 mirror the functions of 

the PEAK1 and PEAK2 buttons of the Calibration 

Windowand can be used to modify FOM Settings without 

switching to the Calibration Window. 

The TIME group displays the state of the hardware timers. 

This information is also available as part of the Acquisition 

Window. The Dead Time is calculated based on the total 

elapsed time. The reported Dead Time will not change when 

the spectrum acquisition is stopped. 

The COUNT RATE group provides life information 

independent of the spectrum acquisition state. The counting 

losses are indication of the dead time on a short time scale. 

At low counting rates, the reported losses may show large 

variations due to the statistical fluctuations. For accurate 

measurement of the Dead Time, the Dead Time reported in 

the TIME group should be used. 

The INCOMING count rate is derived from the fast 

discriminator counting rate corrected for the pile-up losses. 

The correction is based on the parameters of the fast shaper 

and the counting statistic. Caution should be exercised when 

interpreting the counting losses of periodic test signals as 

their time intervals are not randomly distributed. Incorrect 

setup of the coincidence circuit or the inhibit signal may 

cause very large counting losses approaching 100%. 
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Similarly, very low noise thresholds may cause the fast discriminator to respond to 

noise, which will also lead to increased counting losses. 

The CAL check box mirrors the functionality of the Enable Calibration check box of the 

Calibration Window. 

 

Trace Viewer Window 

 

 

Figure 2.2.25. Normal size Trace Viewer Window. 

 

The Trace Viewer acts as a mixed signal oscilloscope and can be used to set and verify 

parameters, to debug hardware configurations and FPGA designs, and to investigate 

detector signal features.  
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Figure 2.2.26. Large Size Trace Viewer Window 

 

The Trace Viewer is a docking window and can be resized. The resizing, however, 

differs from the resizing of the other docking windows. The Trace Viewer can be 

displayed in only two sizes – normal and large. When resizing from normal to large, the 

sizing will take effect if the size of the window frame exceeds the large. When sizing 

down to normal size, the sizing will take affect if the size of the frame becomes smaller 

than the normal size.  

The Trace Viewer is a hybrid solution using hardware resources and software functions 

to capture and display one digital signal waveform and eight logic signal traces. The 

Trace Viewer includes various controls for setting the hardware and selecting the 

software features 
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Figure 2.2.27. Controls and features of the Trace Viewer. 

 

The trace display window displays the digitals signal and the logic signals. The position 

of the logic signals is fixed. The digital signal can be displayed with an offset that is 

selected within the trace display window by the VERTICAL OFFSET control. The 

vertical offset can be reset to zero by pressing the zero button  in the Vertical Offset 

group. 

The horizontal time scale can be selected by using the Horizontal control by pressing + 

or – buttons. The vertical scale is chosen from preset values by pressing + or – buttons 

of the Vertical control.  
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The trace acquisition is controlled by two buttons: ACQUISITION CONTROL and 

ACQUISITION MODE. There are seven acquisition modes that can be selected by 

pressing consecutively the ACQUISITION MODE button.  

 

NRM SGL Av2 Av4 Av8 Av16 RND

 

Figure 2.2.28. Acquisition Mode selection sequence using the ACQUISITION MODE button 

 

The acquisition mode is displayed as a caption of the ACQUISITION MODE button: 

 

  Continuous, triggered acquisition. No averaging of the digital signal. 

  Single, triggered acquisition. No averaging of the digital signal. 

  Continuous, triggered acquisition. 2 samples averaging of the digital signal. 

  Continuous, triggered acquisition. 4 samples averaging of the digital signal. 

  Continuous, triggered acquisition. 8 samples averaging of the digital signal. 

  Continuous, triggered acquisition. 16 samples averaging of the digital signal. 

  Continuous, random acquisition. 

 

The Trace Viewer can be in three acquisition states – stopped, continuous acquisition 

and single acquisition. When the hardware is not connected, the Trace Viewer is always 

in the stopped state. In the stopped state, the ACQUISITION CONTROL caption 

displays “RUN”. To enter the acquisition states, a connection with the hardware must be 

established. 

The single acquisition state is entered by pressing the ACQUISITION CONTROL button 

when its caption displays “RUN” and the acquisition mode is "SGL". After this the 

ACQUISITION CONTROL button will remain depressed and its caption will change to 

“ACQ”. After the single trace acquisition is accomplished, the Trace Viewer re-enters 

the stopped state. 

The continuous acquisition state is entered by pressing the ACQUISITION CONTROL 

button when its caption displays “RUN” and the acquisition mode is not "SGL". The 
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caption of the ACQUISITION CONTROL button changes to “STP” and remains pressed. 

To exit the continuous acquisition state, press the depressed ACQUISITION CONTROL 

button when its caption displays “STP”. 

The Trace Viewer displays one digital signal waveform which can be selected from four 

different sources. The selection of the digital signal is done by depressing one of the 

four buttons in the Input group.  SLOW is the slow shaper signal, FAST is the fast 

shaper signal, ADC is the digitized analog signal after the subtraction of the ADC 

OFFSET. AUX is the same as SLOW in the standard nanoPSD. AUX can be connected 

to other internal digital signals in customized designs. 

The Trigger group contains controls to select trigger source for continuous or single 

triggered acquisitions. The trigger can be selected only from the logic signals. The 

INVERT button defines the trigger edge. When this button is not depressed, the low-to-

high transition of the trigger signal is the acquisition trigger edge forall traces. When the 

button is depressed, the high-to-low transition is the trigger edge. 

The trigger source can be selected by depressing one of the eight trigger buttons in line 

with the logic signal traces. The captions of these buttons also serve as labels for the 

logic signal traces. The F LLD and S LLD are the fast and the slow low level 

discriminators respectively. The PKDT is the peak detection logic strobe signal. The 

STORE is the signal that triggers increments of the channels. PUR is the pile-up 

rejection logic signal. INHIBIT is the internal inhibit signal which disables the base-line 

restorer and the spectrum acquisition. INHIBIT is generated not only when Input C is 

active, but also when the ADC overflows. The INHIBIT button may change to COINC_W 

(coincidence window) button depending of the state of Input R button. The Input R 

button is a dual purpose button. When depressed and clicked, this button changes its 

own functionality and the functionality of the INHIBIT/COINC_W button. There are two 

pairs of button options indicated by the corresponding button options: the first pair is 

Input R + INHIBIT and the second pair is Coinc S and Coinc W. This allows a total of 

ten logic signals to be used as triggers and their traces displayed.  

 



 

©2019 labZY  labZY-PSD  User Manual  Rev. 1a www.labzy.com     61 
 

           

Figure 2.2.29. Input R and Inhibit trigger options. 

The ROI trigger is a very special and useful option, allowing triggering by events with 

pulse heights or TIPS corresponding either to a range of channels or to a single 

channel. When using the ROI trigger, one can identify the cause of anomalies in the 

spectrum by simply marking an ROI and setting the ROI trigger to only those events 

contributing to the ROI channels. To set the ROI trigger, place the spectrum cursor 

within an ROI in one of S0 to S3 spectra and press the ROI trigger button. If the ROI 

trigger button is depressed and pressed again, the ROI boundaries displayed in the 

Trace Viewer will be updated to the boundaries of the ROI that the spectrum cursor is 

placed in. 

CURSOR

ROI

 

Figure 2.2.30. Setting the ROI trigger 
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The Trace Viewer uses a pre-trigger acquisition to capture portions of the signals 

preceding the trigger. The trigger position can be adjusted by the slider TRIGGER 

POSITION. This allows a larger or smaller portion of the pre-trigger signal to be 

captured and displayed. 

The PEAK button and the associated function are unique to the labZY Trace Viewer. 

When this button is depressed, each digital signal waveform is automatically zero 

referenced to its peak. This allows detailed investigation of the peaks of the signals as 

the vertical scale can be set to small values without losing the ability to observe the 

peaks of the digital signal. The PEAK mode and the ROI or PKDT triggers allow fine 

adjustment of the LONG TC by observing the flat top of the digital signal at the highest 

possible vertical resolution.  

 

 

Figure 2.2.31. Peak referenced signal, The PEAK button is depressed. Using  fine Vertical scale 

details of the peak portion of the shaped pulses can be observed. 
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   a)      b) 

Figure 2.2.32. Peak portion of trapezoidal pulses with 200ns rise time and 800ns flat top. Trace 

a) is for gamma interaction in stilbene detector, trace b) represents neutron interaction.  
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Debug Window 

 

 

Figure 2.2.33. Debug Window. 

 

The Debug Window has the direct controls of the FPGA internal registers and can be 

used as a custom design debug device. When the AUTO READ is selected, the 

registers will be updated automatically.  

 

Events Window 

 

Figure 2.2.34. Events Window. 

Various system level events are displayed in the Events Window.  
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Device Bars 

 

Standard 

 

   Figure 2.3.1. Standard device bar. 

Button function from left to right: 

  Information about labZY-PSD application. 

  Open file. 

  Save spectrum as... 

  Restore Layout. 

  Default Layout. 

 

Hardware Control 

  Figure 2.3.2. Hardware not connected. 

  Figure 2.3.3. Hardware connected. Spectrum acquisition stopped. 

  Figure 2.3.4. Hardware connected. Spectrum acquisition in progress. 

Button function from left to right: 

  Automatic search for ports and automatic connection. 

  Manually select port. 

  Connect to hardware. 

  Disconnect from hardware. 

  Erase spectrum and reset timers = RESET. 

  Start spectrum acquisition = START. 

  Stop spectrum acquisition = STOP. 
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View Control 

 

   Figure 2.3.5. Viewer Control device bar. 

Button function from left to right: 

  Linear vertical scale. 

  Logarithmic vertical scale. 

  Automatic vertical scale. 

  Expand vertically. 

  Condense vertically. 

  Expand horizontally around the cursor. 

  Condense horizontally around the cursor. 

  Expand horizontally from the left spectrum view border. 

  Condense horizontally towards the left spectrum view border. 

  Display the full spectrum. 

 

Mouse and Keyboard Functions 

 

The Mouse and the Keyboard are used to navigate and operate the windows and their 

controls. In the Buffer and File Windows, the mouse and the keyboard are used to move 

the spectrum cursor, to mark or unmark regions of interest (ROI), and to adjust the 

spectrum view. Use the SPACE BAR to toggle the spectrum display between: a filled 

histogram (default), dots, a step function, and a line. 

 

Selecting and Moving the Cursor 

 

To select the cursor, first click the right or left mouse button anywhere within the Buffer 

Window or the File Window. The cursor will be positioned at the point of the mouse 

click. To move the cursor, press and hold either the left button or the right button of the 
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mouse. Alternatively, the cursor may be moved left or right by pressing the LEFT 

ARROW KEY or the RIGHT ARROW KEY of the keyboard respectively.  

Marking/Unmarking ROI 

 

To mark an ROI, use the sequence shown below, or press SHIFT+LEFT ARROW KEY 

or SHIFT+RIGHT ARROW KEY respectively. 

PRESS

AND 

HOLD

FIRST

     

PRESS

AND 

HOLD

SECOND

HOLD

     

HOLD HOLD

MARK ROI

 

Figure 2.4.1. How to mark an ROI using the mouse. 

To unmark an ROI, use the sequence shown below, or press CTRL+LEFT ARROW 

KEY or CTRL+RIGHT ARROW KEY respectively. 

PRESS

AND 

HOLD

FIRST

     

PRESS

AND 

HOLD

SECOND

HOLD

     

HOLD HOLD

UNMARK ROI
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Figure 2.4.2. How to unmark an ROI using the mouse. 

Controlling the Spectrum Display 

 

The mouse can be used to control the number of spectrum channels displayed within 

the Buffer Window or the File Window. A double click of the LEFT mouse button 

reduces the number of channels shown within the window - expanding horizontally.  A 

double click of the RIGHT mouse button increases the number of channels shown 

within the window - condensing horizontally. The mouse horizontal control functions are 

shown below. 

 

DOUBLE

CLICK

EXPAND 

HORIZONTALLY

     

DOUBLE

CLICK

CONDENSE 

HORIZONTALLY

 

 

Figure 2.4.3. How to expand and condense the spectrum display horizontally. 

 

The "I" KEY and the "O" KEY can also be used to expand and condense the spectrum 

display horizontally. The section of the spectrum displayed in the Buffer Window or the 

File Window can be selected by sliding the bar of the horizontal slider or by "bumping" 

the cursor to the left or the right borders of the spectrum display window. 
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The mouse and the keyboard can also be used to control the spectrum display 

vertically. The vertical control of the spectrum display determines the number of counts 

displayed within the vertical boundaries of the Buffer Window or the File Buffer. The 

vertical scale is controlled by the MOUSE WHEEL, the UP ARROW KEY of the 

keyboard, the DOWN ARROW KEY of the keyboard, or the vertical sliding bar. The 

MOUSE WHEEL function is illustrated below. 

CONDENSE  

VERTICALLY

     

EXPAND 

VERTICALLY

 

 

Figure 2.4.4. How to expand and condense vertically the spectrum display. 
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Appendix A: labZY-PSD File Format (.lps) 

<?xml version="1.0"?>

<nanoPSD>

 <serialnumber>10012</serialnumber>

<spectrum0>

  <tag>Stilbene; 50keV to 1.2MeV</tag>

  <caption>TIPS</caption>

  <hardsize>4096</hardsize>

  <softsize>4096</softsize>

  <data>

0

82

44

.

. 

.   

346

+567

+1054

+1109

+985

+605

588

561

.

.

.

5

2

1

  </data>

</spectrum0>

<spectrum1>

  <tag>Stilbene; 50keV to 1.2MeV</tag>

  <caption>G+N</caption>

  <hardsize>4096</hardsize>

  <softsize>4096</softsize>

  <data>

0

1

2

.

.

127

438

783

.

.

S0 counts from Channel 0 to Channel 4095. 

An explicit + sign in front of the channel 

counts indicates that the corresponding 

channel is marked as an ROI.

Spectrum0 (S0) + tag 

caption and spectrum size 

information.

Hardware

Spectrum1 (S1)

 



 

©2019 labZY  labZY-PSD  User Manual  Rev. 1a www.labzy.com     71 
 

.

.

25

9

  </data>

</spectrum1>

<spectrum2>

  <tag>Stilbene; 50keV to 1.2MeV</tag>

  <caption>GAMMA</caption>

  <hardsize>4096</hardsize>

  <softsize>4096</softsize>

  <data>

0

+55

+60

.

.  

400

588

561

.

.

5

2

1

  </data>

</spectrum2>

<spectrum3>

  <tag>Stilbene; 50keV to 1.2MeV</tag>

  <caption>NEUTRONS</caption>

  <hardsize>4096</hardsize>

  <softsize>4096</softsize>

  <data>

0

1

2

.

.

127

438

783

.

.

0

0

  </data>

</spectrum3>

Spectrum3 (S3)

Spectrum2 (S2)
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Time and date 

information.

<time>

  <real> 2000.0000</real>

  <live> 1954.4138</live>

  <dead>    2.2793</dead>

  <date>14/07/2018  03:38:22</date></date>

</time>

<calibration0>

  <enabled>NO</enabled>

  <units>0</units>

  <useall>NO</useall>

</calibration0>

<calibration1>

  <enabled>YES</enabled>

  <units>2</units>

  <channelA>    0.0000</channelA>

  <energyA>    0.0000</energyA>

  <useA>0</useA>

  <channelB> 1933.0000</channelB>

  <energyB>  606.0000</energyB>

  <useB>0</useB>

  <useall>YES</useall>

</calibration1>

<calibration2>

  <enabled>NO</enabled>

  <units>0</units>

  <useall>NO</useall>

</calibration2>

<calibration3>

  <enabled>NO</enabled>

  <units>0</units>

  <useall>NO</useall>

</calibration3>

<fom>

  <left1>369</left1>

  <right1>621</right1>

  <left2>636</left2>

  <right2>974</right2>

</fom>

Calibration data

FOM ROIs
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Hardware Register record

Register 0 to Register 127.

<registers>

  <size>128</size>

  <data>

0

8000

160

20

8

.

.

.

.

0

0

0

  </data>

</registers>

<volatile>

  <firmware>50.20</firmware>

  <intemp>49</intemp>

  <slowadc> 0.74</slowadc>

</volatile>

</nanoPSD>

Volatile data
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Appendix B: Setting BDC 

To set the BDC follow these steps: 

1) Use BDC = 1 to setup a measurement, all other measurement parameters must be 

set before proceeding to step 2 

2) Acquire S1 spectrum at 4096 channel soft size and adjust the gain so that there are 

well above  the half of the  full spectrum size (4096) (Fig B1). 

3) Mark an ROI around the middle of the spectrum ( channel 2048). 

4) Place the cursor within the ROI and press ROI-SCA trigger button of the Trace 

Viewer.  

20k

 

Figure B1. BDC not optimally adjusted 
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5) Press/select the following buttons of the Trace Viewer:  ADC, 0, RUN.  

6) Set Trace Viewer Vertical to 4k/div, .place the trigger mark at the middle of the 

window, adjust Horizontal so that the peak of the ADC signal is well visible.  

7) Adjust BDC so that the ADC peak amplitude is about 20k. This completes the 

adjustment 

 

20k

 

 

Figure B2. Optimally adjusted BDC. 

 


